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WELCOME!
Welcome, and thanks for trying Wall-Ace.    We're confident that you'll be favorably impressed with 
this outstanding product.

Wall-Ace is a Windows wallpaper manager with a difference.    While there are several utilities 
available to change your Windows wallpaper, some of them quite good (and some not so good), none 
of them incorporates all of Wall-Ace's features, and some of Wall-Ace's capabilities are not found in 
any other product that we are aware of.

Wall-Ace has been designed from the ground up to be easy to use, and we believe you will find it to 
be intuitive and flexible.    We sincerely hope that it will meet your needs, and that you will be a happy 
and satisfied user of Wall-Ace.    Your recommendation is our greatest advertisement.    If you like 
Wall-Ace, please tell others; if you don't like it, please tell us!    At the end of this manual, you will find 
a comment form.    We hope you'll take a moment to let us know your thoughts about Wall-Ace, 
whether good or bad.    We appreciate your comments and suggestions, and they will receive 
consideration in the development of future versions of Wall-Ace.

Of course, we also hope that you will be motivated to register Wall-Ace.    Wall-Ace is distributed as 
shareware, which gives you the opportunity to try before you buy.    Wall-Ace has a very reasonable 
registration fee, and we have included a form to make registration as easy and convenient as possible. 
Please see the section titled Registration And Benefits for information on how to register Wall-Ace.



A WORD ABOUT SHAREWARE
Wall-Ace is shareware, not free software.    Shareware is not a type of software, but rather a method of
distributing software.    Shareware is distributed by authors through internet archive sites, bulletin 
boards, on-line services, disk vendors, and copies passed among friends and between colleagues.    
Shareware remains copyrighted, commercial software, which you are allowed to evaluate before 
paying for.    However, shareware offers several distinct advantages over retail software.

Users of shareware can interact directly with the program's author, and shareware authors can in turn 
respond to user requests and concerns in a more timely fashion, and can more quickly release updated
versions, than can retail software publishers.

Traditionally, shareware has been much less expensive than retail software, because you pay for the 
software, and not for the expensive advertising, packaging, distribution and retail markups which 
account for the lion's share of the cost of most retail software (after development costs).

The enormous costs involved in launching a new software product in the traditional retail channel 
prevent many independent authors and small companies from developing and promoting their ideas.    
The shareware distribution method allows these same authors and companies to produce and 
distribute quality products, and accounts for many programs on the market today which would 
otherwise have never become available.

Shareware (sometimes referred to as user supported software) has gained phenomenal popularity and 
experienced wide-spread growth, and now plays a major role in the software industry.    Even so, 
shareware can resist market trends, filling smaller markets which are not lucrative enough to interest 
larger companies, and providing useful products which are simply not available through retail 
channels.

It has been said that you should not trust software which does not trust you.    Shareware has helped to
eliminate the annoying and cumbersome copy protection schemes with which companies sometimes 
burden their products because they simply don't trust their users.    Shareware authors, on the other 
hand, freely distribute their products because they believe that users are honest enough to register the
programs they use.    In fact the very nature of shareware distribution is one of trust.

Perhaps the greatest difference between shareware and retail software is shareware's try-before-you-
buy approach, which makes fitting your needs much easier.    Shareware allows you to evaluate a 
program in its actual operating environment on your own system, for a reasonable period of time, 
without cost.    This enables you to determine the suitability, quality, and usefulness of a program 
before you buy.

In fact, shareware has the ultimate money-back guarantee -- if you don't use the product, you don't 
pay for it!    If, after evaluating a product you decide not to continue using it, you simply discard it.    If, 
on the other hand, you do continue to use it, then, and only then do you pay for it.    Registration of 
shareware products, in addition to being required, also provides the incentive for programmers to 
continue to produce quality software.

If you think this try-before-you-buy approach sounds like an ideal way to make your purchasing 
decisions, you're right!    But it can only work with your support.    It is your willingness to register and 
pay for the shareware programs you use which allows shareware authors to support and continue to 
develop high quality products.    The continued availability of quality shareware products depends on 
the honesty of you, the user.

If shareware works, then everyone will benefit.    Please show your support for shareware by registering
those programs you use, and by passing them on to others.    Shareware is kept alive by YOUR support!



WHAT'S NEW
Wall-Ace 1.1 has quite a few new features:

A Hide Icon option has been added.    If active, when Wall-Ace is minimized, its icon is 
invisible.    To reactivate the program, simply run Wall-Ace again; instead of a second copy being run, 
the first instance will be reactivated.

All automatic selection methods now ignore wallpapers whose weight is zero, allowing 
wallpapers to be in the wallpaper list, yet never be chosen by automatic selection.    They may still be 
chosen by direct selection.

The Random selection method has been renamed Random Cyclic, and a new selection method 
named Random has been added.    The new Random selection generates weighted random selections 
from all enabled (weight > 0) wallpapers, without regard to their count.    The newly named Random 
Cyclic selection, as before, generates random selections only from available (count > 0) wallpapers, 
and resets the counts when all have reached zero, in cyclic fashion.    Hence the new name.

The way in which wallpapers are chosen with the Random Cyclic (formerly called Random) 
selection method has been improved.    Previously, the wallpaper was chosen randomly from all 
available wallpapers with an even distribution (unweighted), i.e. all wallpapers with count > 0 had an 
equal probability of selection regardless of their count.    Wallpapers with greater weights simply 
appeared a greater number of times within the cycle, but without greater probability of selection at 
any change.    The selection is now chosen randomly from all available wallpapers with a weighted 
distribution, i.e. those with greater counts have a greater probability of selection at each change.

Wall-Ace now has the ability to play user selected .wav sound files.    A different sound may be
played when the wallpaper is changed manually, when it is changed automatically, or when the 
selection cycle repeats.

The Wallpaper Directory selection panel has been moved from the Preferences window to the 
Edit Wallpaper File List window.    This physical arrangement coincides more closely with the logical 
structure, and makes setup more straight forward.    In addition, it provides more space in the 
Preferences window for the added Sound Options panel.

The alt-hotkeys in the Preferences window have been slightly modified to accomodate the 
changes and additions.

An item titled '(None)' has been added to the top of the list in the Current Wallpaper list box in 
the Main window to allow setting the Windows wallpaper to none.

Previously, if the Windows wallpaper that was current when Wall-Ace was started, as reported 
by win.ini, was not in the wallpaper list, the current entry in the Current Wallpaper list box in the Main 
window was empty.    Now, the current wallpaper, if it is not in the wallpaper list, is added to the end of 
the list in the Current Wallpaper list box and displayed in the Current Wallpaper list box.    It remains a 
valid entry until Wall-Ace is exited, and may be manually selected even after other wallpapers have 
been selected.

Previously, if the Wallpaper Directory was changed and then the Preferneces (now Edit 
Wallpaper File List) Cancel button was pressed, the Wallpaper Directory change was not cancelled, but 
remained in effect.    Fixed.

Previously, if Wall-Ace was minimized when exited, the main window position was incorrectly 
saved as the position of the minimized icon, and with Windows 95 caused an overflow error.    Fixed.

Since the wallace.txt file contained the same information as the wallace.hlp file, the text file 
has been removed and replaced by a readme.txt file.



INTRODUCTION TO WALL-ACE
Wall-Ace is a Windows wallpaper manager which allows you to change your wallpaper on command 
whenever you wish, or to have your wallpaper changed automatically at timed intervals or each time 
Windows starts.    You can choose the wallpaper you wish to have displayed directly from a list of 
wallpapers conveniently accessible in the main window, or you can have Wall-Ace select new 
wallpapers from your wallpaper list either randomly or sequentially.

Wall-Ace brings together abilities not found together in any other single utility, as well as capabilities 
not found anywhere else.    Some of Wall-Ace's unique features are:

can be run either full screen, or quietly from the command line.    In full screen mode, Wall-Ace
can optionally change wallpaper when started, and can optionally exit after the first wallpaper change 
occurs.    In command line mode, Wall-Ace starts, changes the wallpaper, and exits, all without 
appearing on the screen.

combines a user specified wallpaper directory, along with user selected wallpaper files from 
any directory on your system, into a single easy to use wallpaper list.

optionally, can automatically add to your wallpaper list any new wallpaper files which have 
appeared in your wallpaper directory since the last time Wall-Ace was run.

allows you to assign to each wallpaper in your list a weighting, which is the number of times it 
will appear in random selection before the cycle is complete, thus allowing wallpapers to appear more 
or less frequently, as compared to other wallpapers.

Here are some additional features of Wall-Ace:

works with all standard Windows bitmap files (including run length encoded [RLE] files) which 
have a .bmp extension.

can select wallpapers from directories anywhere on your system, not just your WINDOWS 
directory.

any wallpaper in your list can be immediately displayed by selecting it directly from the 
wallpaper list conveniently available in the main window.

new wallpapers can be chosen either randomly or sequentially from your wallpaper list.

a new wallpaper can be automatically selected at timed intervals, as well as each time Wall-
Ace runs.

accumulated time within the current interval can be saved when Wall-Ace exits, and the 
interval resumed when Wall-Ace next runs.

quick access to Wall-Ace's secondary windows via command buttons in the main window.

easy and flexible configuration via Preferences window.

easy addition and editing of wallpapers in your wallpaper list.

individual tile/center settings for each wallpaper in your list.

added wallpapers can be automatically given a tile or center setting, or can have the 
tile/center setting chosen automatically based on the wallpaper file's size.

Wall-Ace is well-behaved -- it doesn't modify your hard drive or system files, or litter your hard
drive with miscellaneous files.



SYSTEM REQUIREMENTS
Wall-Ace runs under either Windows 3.1x, Windows For Workgroups 3.1x, or Windows 95, and requires
the Visual Basic run-time file, vbrun300.dll.



FILES INCLUDED
The following files are included in the archive for this release of Wall-Ace:

wallace.exe the Wall-Ace program file.
wallace.hlp the on-line help file.
readme.txt introduction and quick start instructions.
license.txt Wall-Ace license and distribution guidelines.
orderfrm.txt Wall-Ace order form.
beep.wav a sound file
drip.wav a sound file
boing.wav a sound file
spaceage.wav a sound file
gametime.wav a sound file
spin.vbx provides additional program functionality.
threed.vbx provides additional program functionality.
file_id.diz a short program description for BBSs.



INSTALLATION AND SETUP
New Installation
After extracting the included files from the archive, copy wallace.exe, wallace.hlp, the sound files 
(.wav), and the text files (.txt) to any directory in which you normally place executable Windows 
utilities.    (The text files may be placed in a corresponding documentation directory, and the sound 
files may be placed in another location in which you normally keep sound files, but the files 
wallace.exe and wallace.hlp should be kept together.)

The spin.vbx and threed.vbx files are Visual Basic files which should be placed in your WINDOWS\
SYSTEM directory.    These files are used by certain other Visual Basic programs as well, so you may 
already have copies of them in your WINDOWS\SYSTEM directory.    If so, don't copy these files over top
of the ones you already have; instead simply discard them.

The file_id.diz file exists only to provide a short description of the program to BBSs, and may be 
discarded.

In addition to the above files, the file vbrun300.dll must be in your WINDOWS\SYSTEM directory in 
order for Wall-Ace to run.    This is the Visual Basic runtime file required by all Visual Basic 3.0 
programs.    Following Microsoft recommendations, this file is not included, as it is a large file which 
would substantially increase the size of the archive.    Since it is required by all Visual Basic programs, 
chances are very good that you already have this file in your WINDOWS\SYSTEM directory, but if not, it 
may be downloaded separately from most BBSs and internet archive sites.

Once the files have been placed in their proper directories, simply create an icon for Wall-Ace in any 
group you choose, and installation is complete.    You may wish to create an icon for Wall-Ace in your 
startup group in order to have Wall-Ace run each time Windows starts.    See the topic Using   Wall-Ace  
in the section OPERATION for more information.

When Wall-Ace is run for the first time, (or whenever its .ini file cannot be found), it will create its 
initialization file, wallace.ini, with default values.    This is the ONLY additional file that Wall-Ace will 
add to your system!    Normally, the .ini file is created in the same directory in which wallace.exe 
resides (see the topic The   Wall-Ace   Initialization File   in the OPERATION section for more information).

Upgrade Installation
After extracting the included files from the archive, copy wallace.exe, wallace.hlp, and the text files 
(.txt) over top of the existing files from your previous version.    The old wallace.txt file may be 
discarded, as it has been replaced by the readme.txt file.

Copy the sound files (.wav) to the same directory as your wallace.exe file, or to another location in 
which you normally keep sound files.

The spin.vbx and threed.vbx files from the archive may be discarded, since they should already be in 
your WINDOWS\SYSTEM directory from your previous version.

The file_id.diz file exists only to provide a short description of the program to BBSs, and may be 
discarded.

When Wall-Ace is run for the first time, it will update your wallace.ini file, preserving all your previous 
settings and wallpapers.    If your wallace.ini file cannot be found, Wall-Ace will create a new 
initialization file with default values.



OPERATION
In this section we discuss several topics, which together describe the various ways of using Wall-Ace.  
The section titled Reference provides a reference to all the Wall-Ace windows and controls.

The topics in this section are:

Using   Wall-Ace  
Starting   Wall-Ace  
The   Wall-Ace   Command Line  
Exiting   Wall-Ace  
Using The   Wall-Ace   General Options  
The Wallpaper Directory
Adding Wallpaper Files Automatically
Using Wallpaper Weighting
Methods Of Selecting Wallpaper
Using The Wallpaper Timer
Editing The Wallpaper List
The   Wall-Ace   Initialization File  
The Win.Ini File
Registering   Wall-Ace  



Using Wall-Ace
The most common method of using Wall-Ace is to place a Wall-Ace icon in your startup group to 
have it begin running each time you start Windows, and to configure it to automatically change your 
wallpaper at timed intervals (see the topic Using The Wallpaper Timer in this section).    When placing a
Wall-Ace icon in your startup group, you may wish to configure it to start minimized.

Alternatively, you may wish to start Wall-Ace manually (see the topic Starting   Wall-Ace   in this 
section), rather than have it run each time Windows starts.    This may be accomplished by placing a 
Wall-Ace icon in a Windows group of your choice.    You may also wish to start Wall-Ace each time you
change wallpaper, rather than have it remain running in the background, and you may even wish to 
have Wall-Ace exit immediately after changing the wallpaper (see the topic Using The   Wall-Ace     
General Options in this section).

You can configure Wall-Ace to change wallpaper only on your command, or you can have Wall-Ace 
change wallpaper automatically, either at timed intervals as mentioned above, or immediately when it 
begins running (see the topics Using The Wall-Ace General Options, and The   Wall-Ace   Command Line  
in this section).



Starting Wall-Ace
To start Wall-Ace, simply click the Wall-Ace icon.    Depending on whether or not you have given your 
Wall-Ace icon any command line arguments, Wall-Ace may run either in full-screen mode, or in 
command-line mode.    In full-screen mode, Wall-Ace displays its main window (or its icon, if it was 
started minimized) and waits for your commands or events.    In command-line mode, Wall-Ace starts, 
performs the requested operation, and exits without displaying its window.    See the topic The   Wall-  
Ace   Command Line   in this section for more information.

When Wall-Ace starts, it configures itself according to information in its initialization file.    See the 
topic The   Wall-Ace   Initialization File   in this section for more information.

Wall-Ace may be configured to change the wallpaper as soon as it starts.    This may be done in two 
different ways.    For more information, see the topics The Wall-Ace Command Line, and Using The 
Wall-Ace   General Options   in this section.



The Wall-Ace Command Line
Wall-Ace can accept command line arguments to alter the way in which it operates.    For option 
arguments, note that Wall-Ace accepts either the DOS style switch character '/', or the UNIX style 
option character '-', to introduce them.

Command line arguments may or may not cause Wall-Ace to run in command line mode.    When run 
in command-line mode, Wall-Ace starts, performs the requested operation, and exits.    Its main 
window never appears on the screen.

This version of Wall-Ace recognizes only one command line argument, the Quiet (or Quick change) 
option, /q.    When run with this option, Wall-Ace starts, changes the wallpaper according to the 
selection method chosen in Preferences, and exits quietly without displaying its window.

This is useful when you wish to have Wall-Ace automatically change your wallpaper at certain times 
(for example, each time Windows starts), and manually on your command at other times, without 
having Wall-Ace remain running in the background in between.

As an example, suppose you wish to periodically run Wall-Ace manually to change wallpaper on your 
command, yet still wish to have it change the wallpaper automatically each time Windows starts.    To 
do this, place an icon for Wall-Ace in your startup group with '/q' on the command line.    This will 
make Wall-Ace change the wallpaper each time Windows starts, and exit quietly.    Now place another 
Wall-Ace icon in a different group with an empty command line, from which you can run Wall-Ace 
manually.



Exiting Wall-Ace
Wall-Ace may be terminated in any of the following ways:    choosing Exit from the File menu, pressing
the Exit command button in the main window, double-clicking the control-box in the main window, 
choosing Close from the system menu (the control-box) in the main window, terminating Wall-Ace 
from your task manager, or quitting Windows.

Wall-Ace may also exit immediately after changing the wallpaper, if the Exit After First Change option 
is true.    Wall-Ace will only exit if the wallpaper change occurs due to pressing the Change button in 
the main window (or choosing Change Wallpaper from the File menu), or as a result of a timed change 
or the Change On Startup option, but not as a result of a direct wallpaper selection in the Current 
Wallpaper list box in the main window.

When closed in any of these ways, Wall-Ace may, depending on settings in Preferences, save certain 
information to its initialization file before terminating.    If the Cumulative Time option is true, Wall-Ace
will save the elapsed time in the wallpaper timer's current time interval (see the topic Using The 
Wallpaper Timer in this section for more information).    Also, if the Save Window Positions option is 
true, Wall-Ace will save the current positions of its windows.



Using The Wall-Ace General Options
Wall-Ace provides several general options to allow you to configure it to work the way you want it to.   
The general options settings are found in the Preferences window, which is accessed from the main 
window either by choosing Preferences... from the Options menu, or by pressing the Preferences 
command button.

The Change On Startup option, when true, causes Wall-Ace to change the wallpaper as soon as it 
starts running.    The new wallpaper is chosen according to the Selection Method set in Preferences, 
and the wallpaper timer is reset.    The Cumulative Time option has no effect when Change On Startup 
is true, since the restored time is immediately reset when the wallpaper is changed as Wall-Ace 
begins running.

The Exit After First Change option, when true, causes Wall-Ace to exit immediately after the wallpaper
is changed due to pressing the Change button in the main window (or choosing Change Wallpaper from
the File menu), or as a result of a timed change or the Change On Startup option, but not as a result of 
a direct wallpaper selection in the Current Wallpaper list box in the main window.

The Exit After First Change and Change On Startup options should not be used together, since if both 
options are enabled then each time Wall-Ace runs it will start, immediately change the wallpaper, and
exit.    If this is what you want, you should use the /q command line option instead (see the topic The 
Wall-Ace   Command Line   in this section).    If both options are enabled, the Wall-Ace window will not 
appear, and you will be unable to access the Preferences window to change any settings unless you 
first edit (or delete) the wallace.ini file and manually set either or both of these options to false.    The 
Exit After First Change option, (which may be removed in a future release), exists only for compatibility
with certain other utilities, in which it was implemented in an attempt to work around the lack of a 
command line switch, such as Wall-Ace DOES have.

The Save Window Positions option, when true, causes Wall-Ace to save the current window positions 
when it exits, and to restore the saved positions when it starts, so you can have Wall-Ace always start
in a position of your choice.

The Hide Icon option, when true, will cause the Wall-Ace icon to be invisible when Wall-Ace is 
minimized.    In order to restore the Wall-Ace window, simply run the program again.    Instead of a new
copy of the program, the previous instance will be restored.



The Wallpaper Directory
Wall-Ace allows your custom wallpaper list to contain wallpaper files which may reside in any, or 
many, directories on your system.    What, then is the purpose of the wallpaper directory?

Simply put, the wallpaper directory enables one of Wall-Ace's most interesting features -- the 
automatic addition of new wallpaper files to your wallpaper list.    See the topic Adding Wallpaper Files 
Automatically in this section for information on how to use this feature.

In addition, many users find it convenient to keep all of their bitmap (.bmp) files which they use for 
wallpaper together in a single directory other than their WINDOWS directory, both to avoid clogging 
the WINDOWS directory, and as an aid to organization.

The wallpaper directory can be changed from the Edit Wallpaper File List window, either by choosing 
the Browse command button, or by entering the directory path directly into the Wallpaper Directory 
text box.



Adding Wallpaper Files Automatically
Suppose you frequently preview many new image files, some of which you desire to use for wallpaper.  
After converting (if necessary) the files to bmp format (the only format which Windows can use for 
wallpaper), all you need do is move the bitmap files into your wallpaper directory.    If you have enabled
the Auto Add feature, Wall-Ace will automatically add these new files to your wallpaper list the next 
time it is run, saving you the need to manually edit your wallpaper list each time you add some new 
wallpapers.

This is how it works.    Each time Wall-Ace starts, it checks the Auto Add Enable option.    If set, Wall-
Ace scans your wallpaper directory and adds to your wallpaper list each bitmap (.bmp) file found in 
the directory which is not already in the list.

The tile/center attribute of added files is determined by the three option switches in the Auto Add 
Options panel of Preferences.    If the Tile option is set, added files will have the tile attribute; if the 
Center option is set, added files will have the center attribute.    If the Auto Select Tile/Center option is 
set, files whose size is greater than or equal to 100,000 bytes will have the center attribute; those 
whose size is less than 100,000 bytes will have the tile attribute.

Files added in this way will be given the weight specified in the Auto Add Weight option.    Setting this 
to a large value relative to the values of other wallpapers will make newly added wallpapers appear 
more frequently when using the Random or Random Cyclic selection methods; setting it to a small 
relative value will make newly added wallpapers appear less frequently; setting all wallpaper values to 
one will make them all appear with equal frequency.    If you wish new wallpapers to be added to the 
wallpaper list but not appear until you choose them, set the Auto Add Weight value to zero, and they 
will not appear in automatic selection.    See the topic Using Wallpaper Weighting in this section for 
more information.



Using Wallpaper Weighting
Weighting brings you additional flexibility and control of the frequency and selection of wallpapers to 
be displayed, and is one of Wall-Ace's unique features.    Each wallpaper in your wallpaper list may be 
assigned a specific weight, which will determine how often that wallpaper will be displayed relative to 
other wallpapers in the list, when using Random or Random Cyclic selection.    Weighting has no effect 
in Sequential selection mode.

You set the weight for an individual wallpaper or a group of wallpapers by selecting those wallpapers in
the Wallpaper File List in the Edit Wallpaper File List window, and either double-clicking in the list, or 
pressing the Weight command button.    When wallpapers are added to the list, either by user 
command or by way of the Auto Add feature, they are initially given the weight specified in the Auto 
Add Weight option in the Auto Add Options panel of the Preferences window.

Weights may range from zero to 100.    Setting a wallpaper's weight to a large value relative to the 
weighting of other wallpapers in the list, will cause that wallpaper to appear move frequently than 
wallpapers with lesser weighting, while setting a wallpaper's weight to a value lower than that of other 
wallpapers will cause it to appear less frequently than those with a greater weighting.    To see exactly 
how this is done, see the discussion of the random selection modes in the topic Methods Of Selecting 
Wallpaper in this section.

Using this method, you can give your favorite wallpapers a large weighting to make them appear 
frequently, and give other wallpapers a lesser weighting to have them appear less often.

If you assign a weight of zero to a wallpaper, that wallpaper will never appear by automatic selection.   
This is useful if you are using the Auto Add feature and have files which you wish to keep in your 
wallpaper directory, but do not wish to have displayed.    If you simply remove them from the wallpaper
list, the Auto Add feature will cause them to be put back in the list the next time Wall-Ace is run.    
Instead, you can set their weight to zero, and while they will still be found in the list, they will no longer
appear in automatic selection mode.    In other words,    wallpapers whose weight is zero will never be 
chosen by the Change button in the main window (or choosing Change Wallpaper from the File menu), 
or as a result of a timed change or the Change On Startup option.    The only time they will be chosen is
if they are directly selected in the Current Wallpaper list box in the main window.

Weighting affects the frequency of display of wallpapers only in Random or Random Cyclic selection 
mode, which occurs (if Random or Random Cyclic selection is set in Preferences) when the wallpaper is
changed due to pressing the Change button in the main window (or choosing Change Wallpaper from 
the File menu), or as a result of a timed change or the Change On Startup option, but not as a result of 
a direct wallpaper selection in the Current Wallpaper list box in the main window.    In particular, setting
a wallpaper's weight to zero does not prevent it from being chosen in the Current Wallpaper list box, 
but selecting a wallpaper in the Current Wallpaper list box DOES cause its usage count to be updated.



Methods Of Selecting Wallpaper
Wall-Ace provides several ways to change wallpaper, and several methods of selecting which 
wallpapers to display, giving you a great deal of flexibility in deciding how and when wallpaper 
changes should occur.

The most direct method of changing the wallpaper is to choose a new wallpaper from the Current 
Wallpaper drop-down list in the main window.    With this method, you directly select which wallpaper 
will be displayed.

Equally as easy, you can simply press the Change command button (or choose Change Wallpaper from 
the File menu) in the main window.    Using this method, the wallpaper chosen will be determined by 
the selection method set in Preferences, as discussed below.

Perhaps the easiest way of changing the wallpaper is to let Wall-Ace do it for you automatically, either
by having Wall-Ace change the wallpaper when it starts (see the topics The   Wall-Ace   Command Line  ,
and Using The   Wall-Ace   General Options   in this section), or by having Wall-Ace change the wallpaper
at intervals (see the topic Using The Wallpaper Timer in this section).    As in the case above, the 
wallpaper chosen in this case will be determined by the selection method set in Preferences.

The Selection Method panel in the Preferences window provides for having wallpapers chosen for 
display in different ways.    The simplest of these is Sequential, in which the next wallpaper to be 
displayed is simply the one following the current wallpaper in the wallpaper list.    When the end of the 
list is reached, the first wallpaper in the list is chosen again.    Wallpapers whose weight is zero will not 
be selected.

In Random Cyclic selection, the list is also displayed in a cyclic fashion, but in random order, rather 
than sequentially.    In addition, wallpapers may be displayed more than once in a single cycle, or not at
all, depending on their weighting.    In this mode, the length of a cycle is the sum of the weights of all 
the wallpapers in the list.    At the beginning of the cycle, each wallpaper's usage count is set equal to 
its weight.    Each time a new wallpaper is to be chosen, the usage counts of all wallpapers whose 
usage count is greater than zero is summed and a random number generated in that range.    The 
chosen wallpaper's usage count is decremented, and when all wallpapers' usage counts are zero, the 
cycle is repeated.

In Random selection, the weights of all wallpapers whose weight is greater than zero is summed and a 
random number generated in that range.    This mode yields a simple random selection, and like 
Random Cyclic, has a weighted distribution, i.e. wallpapers with greater weights have a greater 
probability of being selected.    Unlike Random Cyclic, this mode is not cyclic in nature, since the 
random selection is based on the weights, which don't change with selection, rather than on the 
counts which do change with each selection.    (The chosen wallpaper's count is decremented, but the 
counts are ignored in this selection mode.)



Using The Wallpaper Timer
The wallpaper timer is possibly one of the most frequently used features of Wall-Ace, perhaps 
because it contributes so much to the character of the program.    After all, having your wallpaper 
changed periodically and fully automatically is not only the easiest way of changing wallpapers, and 
the most visible aspect of the program's operation, it also provides a pleasant distraction from the 
everyday work aspect of your computer's operation.    In other words, it's just plain fun, especially if 
you have a good selection of attractive wallpapers!

In addition, it's very easy to use.    In the Timer panel of Preferences, simply set the Timer Enabled 
option to true, and select the number of minutes you wish to elapse between wallpaper changes.    The 
number of minutes may range from one to 32,767, or about 546 hours, which is a little more than 22 
days.    When you have it set to your liking, you may want to minimize the main window to have Wall-
Ace run quietly in the background, changing your wallpaper for you just the way you have set it to.

Each time the selected time period has elapsed, Wall-Ace will select a new wallpaper according to the
Selection Method set in Preferences, and reset the wallpaper timer to begin another period.

If you set the Cumulative Time option true, the time elapsed since the wallpaper was last changed is 
saved when Wall-Ace exits, and restored when Wall-Ace starts, thus allowing a time interval to be 
continued from one Windows session to the next.    The first timed wallpaper change after Wall-Ace 
next starts will occur upon completion of the restored time interval.    If the Cumulative Time option is 
false, the elapsed time is not saved or restored, and the first timed wallpaper change will occur one full
time interval after Wall-Ace starts.

The Cumulative Time option will have no effect if the Change On Startup option is true, since the time 
interval restored by the Cumulative Time option will be immediately reset when the wallpaper is 
changed as a result of the Change On Startup option when Wall-Ace begins running.



Editing The Wallpaper List
Wall-Ace provides for easy editing of your wallpaper list in the Edit Wallpaper File List window, which 
is reached by pressing the File List command button in the main window, or the File List command 
button in the Preferences window.

The wallpaper list may contain wallpaper files which may reside in many different directories on your 
system.    The Files panel displays all the bitmap (.bmp) files in a particular directory on your disk, 
which may be browsed in a manner similar to a standard Open File dialog.    Any file or group of files 
(contiguous or not) in the Files panel may be selected for addition to the wallpaper list.    Pressing the 
All command button will select all files in the Files panel.    Once you have selected a file or files, 
pressing the Add command button or double-clicking in the File panel will add the selected files to the 
end of the wallpaper list.

In a similar manner, any file or group of files (contiguous or not) in the Wallpaper List panel may be 
selected for editing or removal.    When a wallpaper file or files have been selected, pressing the Tile 
command button will give all the selected files the tile attribute, and pressing the Center command 
button will give all the selected files the center attribute.    Pressing the Weight command button or 
double-clicking in the Wallpaper List panel will display the Edit Weight window, in which a new weight 
can be chosen, to be given to all selected wallpaper files.    Pressing the Remove command button will 
remove any selected wallpapers from the list, after first asking for confirmation.

The Clear command button is available even when no wallpaper files have been selected.    Pressing 
this button will remove ALL wallpapers from the list, after first ask for confirmation.



The Wall-Ace Initialization File
When Wall-Ace starts, it looks for its initialization file, wallace.ini, in the same directory from which it 
was run (the directory in which you placed the wallace.exe file).    If it is not found there, Wall-Ace 
looks in your WINDOWS directory.    If Wall-Ace cannot find its initialization file, it creates a new one 
with default values, in the directory from which it was run.    This is the ONLY additional file that Wall-
Ace will add to your system!

When creating its initialization file, Wall-Ace sets its wallpaper directory to your WINDOWS directory, 
and sets the Auto Add Enabled option to true by default (see the topic Adding Wallpaper Files 
Automatically in this section).    Therefore, any bitmap (.bmp) files found in your WINDOWS directory 
will automatically be added to your wallpaper list.    You may wish to change your wallpaper directory 
(see the topic The Wallpaper Directory in this section), or edit your wallpaper list (see the topic Editing 
The Wallpaper List in this section).



The Win.Ini File
When Wall-Ace starts, it determines the current wallpaper by examining your win.ini file.    Whenever 
Wall-Ace changes your wallpaper, it updates the win.ini file.    Wall-Ace always attempts to keep the 
win.ini file in sync with the actual state of the system.    This is the ONLY change that Wall-Ace will 
make to your system files!



Registering Wall-Ace
To register Wall-Ace, first go to the Registration window.    This window may be accessed by choosing 
Register Wall-Ace... from the Options menu in the main window, or by pressing the Register command
button in either the About box or the startup splash screen.

In the Registration window, print the order form by pressing the Print Form command button.    
Complete and send the order form with the registration fee to the address shown on the order form.

When you receive your individual registration code, go to the Registration window, enter your 
Registration Name and Registration Code exactly as they were received, including case and 
punctuation, and press OK.    You now have a registered version of Wall-Ace.

See the section Registration And Benefits for more information.



REFERENCE
This section provides a concise description of all Wall-Ace windows and the controls they contain.    
The topics in this section are:

The   Wall-Ace   Main Window  
The Preferences Window
The Select Sound File Window
The Edit Wallpaper File List Window
The Select Wallpaper Directory Window
The Edit Weight Window
The About Window
The Registration Window



The Wall-Ace Main Window
Click on different areas in the graphic below for more information.

The main window contains the menu bar, a drop-down list box allowing convenient direct selection of 
any wallpaper in your list, and command buttons to quickly and easily change wallpaper, access the 
Preferences window, access the Edit Wallpaper File List window, and exit Wall-Ace.    Each of these 
items is described below.

Menu Bar:    the Wall-Ace menu bar contains the following menus:
          File:    the File menu has the following choices:

Change Wallpaper:    immediately changes the wallpaper according the selection method set in 
Preferences, and resets the wallpaper timer.    If the Exit After First Change option is set, Wall-
Ace exits.    This is the same as pressing the Change command button.

Exit:    causes Wall-Ace to exit.    The elapsed time in the current wallpaper timer interval, and 
the current window positions, are first saved to the initialization file, if selected in Preferences.    
This is the same as pressing the Exit command button.

          Options:    the Options menu has the following choices:
Preferences...:    displays the Preferences window, from which all options may be set.    This is the 
same as pressing the Preferences command button.

Edit Wallpaper File List...:    displays the Edit Wallpaper File List window, from which the wallpaper
list may be edited. This is the same as pressing the File List command button.

          Help:    the Help menu has the following choices:
Contents:    displays the Wall-Ace help file at the Contents page.

Register Wall-Ace...:    displays the Registration window.

About Wall-Ace...:    displays the About Wall-Ace window.

Current Wallpaper:    a drop-down list box which lists all the wallpapers currently defined in your 
wallpaper list.    When Wall-Ace starts, the current Windows wallpaper, as reported by win.ini, is the 
current item in this box.    Selecting an item in this box immediately changes your Windows wallpaper 
to the selected item, and resets the wallpaper timer.    The first item in this box's list is '(None)'.    
Choosing this item will set the Windows wallpaper to None.    The Exit After First Change option does 
not apply to direct selection via this list box, so Wall-Ace does not terminate.

Change:    this command button immediately changes the wallpaper according the selection method 
set in Preferences, and resets the wallpaper timer.    If the Exit After First Change option is set, Wall-
Ace exits.    This is the same as selecting Change Wallpaper from the File menu.

Preferences:    this command button displays the Preferences window, from which all options may be 
set.    This is the same as selecting Preferences... from the Option menu.



File List:    this command button displays the Edit Wallpaper File List window, from which the wallpaper
list may be edited.    This is the same as selecting Edit Wallpaper File List... from the Option menu.

Exit:    this command button causes Wall-Ace to exit.    The accumulated time in the current wallpaper 
timer interval, and the current window positions, are first saved to the initialization file, if selected in 
Preferences.    This is the same as selecting Exit from the File menu.



The Preferences Window
Click on different areas in the graphic below for more information.

The Preferences window contains the Selection Method panel, the General Options panel, the Timer 
panel, the Auto Add Options panel, the Sound Options panel, and command buttons to quickly access 
the Edit Wallpaper File List window, access the Wall-Ace on-line help, and exit the Preferences window.
Each of these items is described below.

Selection Method:    this panel allows setting the selection method, which may be one of the 
following:

Random:    wallpapers are chosen randomly from the wallpaper list, with a weighted distribution 
based on each wallpaper's weight.

Random Cyclic:    wallpapers are chosen randomly from the wallpaper list, with each being 
chosen the number of times indicated by its weight before the cycle is repeated.

Sequential:    wallpapers are chosen sequentially through the wallpaper list, and the list is then 
repeated, without regard to wallpaper weight settings.

General Options:    this panel allows setting the general options, which are described below:

Change on startup:    if true, Wall-Ace will change the wallpaper according to the selection 
method specified in Preferences when it starts, in a manner identical to pressing the Change 
button in the main window.    This option should not be used with the Exit After First Change 
option; see the topic Using The Wall-Ace General Options in the OPERATION section for more 
information.



Exit after first change:    if true, Wall-Ace will exit immediately after changing the wallpaper 
either by pressing the Change button (or choosing Change Wallpaper from the File menu) in the 
main window, by a timed change, or by the Change On Startup option, but not by a direct 
wallpaper selection in the Current Wallpaper list box in the main window.    Before exiting, Wall-
Ace will save the wallpaper timer current interval's elapsed time, and the current window 
positions, if selected in Preferences.    This option should not be used with the Change On Startup
option; see the topic Using The Wall-Ace General Options in the OPERATION section for more 
information.

Save window positions:    if true, Wall-Ace will save the current window positions when it exits, 
and will restore the saved positions when it starts.

Timer:    this panel allows setting the timer options, as follows:

Enabled:    if true, Wall-Ace will change the wallpaper at intervals of the selected length.    If 
false, timed changes will not occur.

Cumulative time:    if true, the time elapsed since the wallpaper was last changed is saved when 
Wall-Ace exits, and restored when Wall-Ace starts.    The first timed wallpaper change after 
Wall-Ace next starts will occur upon completion of the saved time interval.    If false, the elapsed
time is not saved or restored, and the first timed wallpaper change will occur one full interval 
after Wall-Ace starts.

Note that if the Change On Startup option is true, the wallpaper will be changed and the timer 
reset when Wall-Ace starts, so the Cumulative Time option will have no effect.

Interval Minutes:    specifies the number of minutes between timed wallpaper changes when the 
timer is enabled; the associated spinner provides for quick increases or decreases of the current 
time.

Auto Add Options:    this panel allows setting the auto add options, which are described below:

Auto Add Enabled:    if true, each time Wall-Ace starts it searches your wallpaper directory, and 
automatically adds to your wallpaper list any bitmap (.bmp) files which are not already in the 
list.

Tile:    if true, wallpapers automatically added to the wallpaper list will have the tile attribute.

Center:    if true, wallpapers automatically added to the wallpaper list will have the center 
attribute.

Auto Select Tile/Center:    if true, each wallpaper automatically added to the wallpaper list will 
have the center attribute if its file size is greater than or equal to 100,000 bytes, and will have 
the tile attribute if its file size is less than 100,000 bytes.

Weight:    specifies the weight given to each wallpaper automatically added to the wallpaper list; 
the associated spinner provides for quick increases or decreases of the current weight.

Sound File Options:    this panel allows setting the sounds to be playd when the wallpaper is 
changed, which are described below:

Sounds Enabled:    if true, the specified sound file will be played each time the wallpaper is 
changed.

Auto Change:    specifies the sound file to be played when the wallpaper is changed due to the 
Change On Startup option or as a result of a timed change.

Manual Change:    specifies the sound file to be played when the wallpaper is changed by direct 
selection in the Current Wallpaper list box, by pressing the Change button, or by choosing 
Change Wallpaper from the File menu.



Begin Cycle:    specifies the sound file to be played when a Sequential or Random Cyclic change 
begins a new cycle.

File List:    this command button displays the Edit Wallpaper File List window, from which the wallpaper
list may be edited.

Help:    this command button displays the Wall-Ace help file.

OK:    this command button exits the Preferences window and causes all the Preferences to be saved in 
the initialization file, and used in the current session.

Cancel:    this command button exits the Preferences window without saving any changes made, and 
without using any changes in the current session.



The Select Sound File Window
Click on different areas in the graphic below for more information.

The Select Sound File window contains the Files panel, and command buttons to exit the Select Sound 
File window.    Each of these items is described below.

Files:    this panel displays drives, directories, and sound (.wav) files, allowing the selection of the 
sound file to be used.    It is similar to a standard file open dialog.

OK:    this command button exits the Select Sound File window and causes the selected sound file to be
used.

Cancel:    this command button exits the Select Sound File window without changing the sound file.



The Edit Wallpaper File List Window
Click on different areas in the graphic below for more information.

The Edit Wallpaper File List window contains the Wallpaper Directory selection panel, the Files panel, 
the Wallpaper List panel, and command buttons to easily edit the wallpaper list, access the Wall-Ace 
on-line help, and exit the Edit Wallpaper File List window.    Each of these items is described below.

Wallpaper Directory:    this panel allows setting and viewing the wallpaper directory, and contains 
the following items:

Wallpaper Directory:    this text box displays the current wallpaper directory, and allows directly 
entering a new directory path.

Browse:    this command button displays the Select Wallpaper Directory window, from which a 
new wallpaper directory may be selected.

Files:    this panel displays drives, directories, and bitmap (.bmp) files, and allows the selection of one 
or more files for addition to the wallpaper list.    It is similar to a standard file open dialog.

Wallpaper List:    this panel displays the wallpaper list, showing for each wallpaper the full path and 
filename, the tile/center attribute, and the weight, and allows selection of one or more wallpapers to 
edit.    Double clicking is identical to pressing the Weight command button.

All:    this command button selects all files in the Bitmap Files list box of the Files panel, for possible 
addition to the wallpaper list.

Add:    this command button adds the files selected in the Bitmap Files list box of the Files panel to the 
wallpaper list.    The added files' tile/center options and weights will be determined by the Auto Add 
Options selected in the Preferences window, in the same way as files automatically added, and may be
further edited after addition.



Remove:    this command button removes the files selected in the Wallpaper List panel from the 
wallpaper list, after prompting for confirmation.

Clear:    this command button clears (removes ALL files from) the wallpaper list, after prompting for 
confirmation.

Tile:    this command button causes all files selected in the Wallpaper List panel to be given the tile 
attribute.

Center:    this command button causes all files selected in the Wallpaper List panel to be given the 
center attribute.

Weight:    this command button displays the Edit Weight window, allowing the weight to be set for all 
files selected in the Wallpaper List panel.

Help:    this command button displays the Wall-Ace help file.

OK:    this command button exits the Edit Wallpaper File List window and causes the wallpaper list to be
saved in the initialization file, and used by the current session.

Cancel:    this command button exits the Edit Wallpaper File List window without saving any changes 
made, and without using any changes in the current session.



The Select Wallpaper Directory Window
Click on different areas in the graphic below for more information.

The Select Wallpaper Directory window contains the Files panel, and command buttons to exit the 
Select Wallpaper Directory window.    Each of these items is described below.

Files:    this panel displays drives, directories, and bitmap (.bmp) files, allowing the selection of the 
directory to be used as your wallpaper directory.    It is similar to a standard file open dialog.

OK:    this command button exits the Select Wallpaper Directory window and causes the selected 
directory to be displayed in the Wallpaper Directory text box of the Preferences window.

Cancel:    this command button exits the Select Wallpaper Directory window without changing the 
contents of the Wallpaper Directory text box of the Preferences window.



The Edit Weight Window
Click on different areas in the graphic below for more information.

The Edit Weight window contains the Weight text box, and command buttons to exit the Edit Weight 
window.    Each of these items is described below.

Weight:    this text box allows direct entry of the weight to be used for all files selected in the 
Wallpaper List panel of the Edit Wallpaper File List window; the associated spinner provides for quick 
increases or decreases of the current weight.

OK:    this command button exits the Edit Weight window and causes the specified weight to be used 
for all files selected in the Wallpaper List panel of the Edit Wallpaper File List window.

Cancel:    this command button exits the Edit Weight window without changing the weights of the files 
selected in the Wallpaper List panel of the Edit Wallpaper File List window.



The About Window
Click on different areas in the graphic below for more information.

The About window contains the copyright notice, registration and contact information, and command 
buttons to access the Registration window and to exit the About window.



The Registration Window
Click on different areas in the graphic below for more information.

The Registration window contains the Registration Name and Registration Code text boxes to allow 
entering your registration data, and command buttons to print the order form and to exit the 
Registration window.



REVISION HISTORY
1.0    96/09/15 - first public release.

1.1    96/12/31.
Added Hide Icon option to make icon invisible when Wall-Ace is minimized.
All automatic selection methods now ignore wallpapers whose weight is zero.
Random selection method renamed Random Cyclic, and new selection method named Random

added.
Random Cyclic selection method improved; now selectes new wallpaper with a weighted 

distribution.
Added ability to play user selected .wav sound files when the wallpaper is changed manually, 

when it is changed automatically, or when a new cycle begins.
Wallpaper Directory selection panel moved from Preferences window to Edit Wallpaper File List 

window.
Alt-hotkeys in Preferences window slightly modified to accomodate changes and additions.
Added item titled '(None)' to the top of the list in the Current Wallpaper list box to allow setting

the Windows wallpaper to none.
If the current Windows wallpaper when Wall-Ace is started, as reported by win.ini, is not in the

wallpaper list, it is now added to the end of the Current Wallpaper list box list and displayed in the 
Current Wallpaper list box.

Previously, if the Wallpaper Directory was changed and then the Preferneces (now Edit 
Wallpaper File List) Cancel button was pressed, the Wallpaper Directory change was not cancelled, but 
remained in effect.    Fixed.

Previously, if Wall-Ace was minimized when exited, the main window position was incorrectly 
saved as the position of the minimized icon, and with Windows 95 caused an overflow error.    Fixed.

Since the wallace.txt file contained the same information as the wallace.hlp file, the text file 
has been removed and replaced by a readme.txt file.



WHY WALL-ACE?
There are several utilities available to change your Windows wallpaper, some of them quite good (and 
some not so good).    Unfortunately, none of them had the feature set and ease of use we were looking 
for.

One of the best we have found, PaperChg is excellent in that it is small and unobtrusive, allows quick 
and easy direct selection of wallpapers, and functions well as a timed wallpaper changer.    However, 
PaperChg does have a few shortcomings, which we have worked hard to address in Wall-Ace.

Firstly, in PaperChg you may have a custom list of wallpapers, or you may choose to have a wallpaper 
directory, but you cannot have both operational at the same time -- you must choose between them.    
Furthermore, if configured to use a wallpaper directory, PaperChg will choose from ALL wallpaper files 
in that directory, you cannot limit those with which you would like it to work.    We feel it is much more 
convenient for you to be able to maintain a custom list of wallpapers from anywhere on your system, 
while still enjoying the benefits of a specific wallpaper directory, under your control.

Secondly, PaperChg and some others have options like Change On Startup and Exit After Change, but 
they have no way to consolidate the two operations into a single function.    For example suppose you 
wish to have your utility start, change wallpaper and exit, each time Windows starts, but you would 
also like to be able to start your utility manually to change your wallpaper whenever you wish.    Using 
the two options together will accomplish the first part.    Unfortunately, this creates a problem of its 
own, as the author of PaperChg notes:

"If both options are enabled, then whenever PaperChg is run, [it] will immediately change your 
wallpaper and then quit.    Because of this, if you decide you want to change any PaperChg 
setting, you will have to edit the PAPERCHG.INI file manually and either change the Change 
Wallpaper on Startup or Quit after First Wallpaper Change setting to No.    A better solution" ... 
"will be a command line option."

Furthermore, the second requirement in the above example remains unaccounted for, since you 
cannot use the utility manually when it has both options set, due to this problem.    The solution, as 
PaperChg's author notes, is a command line option, such as the Wall-Ace /q option.

Finally, a feature not available in PaperChg (and most others) which we feel is important is the 
availability of command buttons to accomplish tasks quickly and easily, especially those in the main 
window:    Change, Prefs, File List and Exit, in much the same way as the Current Wallpaper drop-down 
list box makes direct selection of wallpapers very quick and easy.

One other point that's worth noting:    PaperChg does not update your win.ini file after changing your 
wallpaper.    There seems to be some difference of opinion on this, since about half of the utilities we 
have seen do update win.ini, and the rest do not.    However, we feel it is best to keep win.ini in sync 
with the actual state of the system.

We hope you like the manner in which each of these issues has been addressed in Wall-Ace.    Of 
course, there are also a host of additional features in Wall-Ace, many of which are not available 
anywhere else, which we believe set Wall-Ace head and shoulders above the rest.
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LICENSE AGREEMENT
YOU SHOULD CAREFULLY READ THE FOLLOWING TERMS AND CONDITIONS BEFORE USING 
THIS SOFTWARE.

Wall-Ace, its executable files, help files, documentation, and icon are Copyright 1996 by Sidney D. 
Peters.    All Rights Reserved.

Unregistered Version
You are granted a limited license to use and evaluate this software for a period of 30 days, for the 
express purpose of determining whether this software is suitable for your needs.    At the end of this 
period, you must either register this software or discontinue using it.

You are granted a limited license to distribute exact copies of the unregistered version of this software, 
provided that the entire product, including the executable files, help files, documentation, and icon, is 
distributed in its full and unmodified form, provided that no fee is charged other than a nominal 
distribution fee, and provided that the purchaser is informed in advance that the distribution fee does 
NOT relieve said purchaser from paying the registration fee for Wall-Ace.

Registered Version
A single user license permits a single registered copy of Wall-Ace to be used, EITHER by a single 
person who uses the software on one or more computers, provided that the software is not in use on 
more than one computer at the same time, OR on a single computer which is used by one or more 
persons, provided that the software is not in use by more than one person at the same time, BUT NOT 
BOTH.    The registered version of Wall-Ace may be accessed through a network, provided that you 
have obtained a single user license for every computer that will access the software through the 
network.

The registered version of the software may not be distributed in any way, by any one other than the 
author or his authorized agent, without prior written consent from the author.

All Versions
Title to the software is NOT transferred to the end user or to any one else.    Title to the software 
remains the property of the author.

DISCLAIMER OF WARRANTY

THIS SOFTWARE AND ACCOMPANYING DOCUMENTATION ARE PROVIDED "AS IS" AND 
WITHOUT WARRANTY OF ANY KIND, WHETHER EXPRESS OR IMPLIED, INCLUDING BUT NOT 
LIMITED TO ANY IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE.    THE USER MUST ASSUME THE ENTIRE RISK OF USING THIS 
PRODUCT.    IN NO EVENT SHALL SIDNEY D. PETERS BE HELD LIABLE FOR ANY DAMAGE, 
DIRECT OR CONSEQUENTIAL, RESULTING FROM THE USE OF THIS PRODUCT.    USE OF THIS 
PRODUCT CONSTITUTES ACCEPTANCE OF THE TERMS OF THIS DISCLAIMER OF WARRANTY.

This license constitutes the complete and exclusive statement of license agreement for Wall-Ace, and 
supersedes any and all previous agreements, oral or written.

BY USING THE SOFTWARE YOU ACKNOWLEDGE THAT YOU HAVE READ AND UNDERSTAND 
THIS LICENSE, AND AGREE TO BE BOUND BY ITS TERMS AND CONDITIONS.



REGISTRATION AND BENEFITS
Wall-Ace is shareware and is provided for evaluation at no charge to the user.    Feel free to pass along
copies of the unregistered version of the program to friends and colleagues for evaluation.    Please 
encourage them to register their copy if they find it useful.    You are also encouraged to upload the 
unregistered version of the program to any BBSs you use. Please keep all the files together.    All 
distribution is subject to the conditions outlined in the license agreement.

If you obtained Wall-Ace from a disk vendor, a bulletin board, internet archive site or on-line computer
service, a friend or colleague, or another similar source, you have an unregistered (evaluation) copy. 
This is not a disabled or demo copy, but the complete working version of the program.    Shareware 
authors believe that you should be able to evaluate a program in its actual operating environment on 
your own system, for a reasonable period of time, without cost.    We believe that an important part of 
the shareware concept is that users must have a chance to fully test all parts of the software.    You 
may try out the complete program at your own pace, and then decide if Wall-Ace is an application you
want to continue using.

Retail software is too often overpriced.    The essence of shareware is to provide users with quality 
software without high prices, and at the same time to provide the incentive for programmers to 
continue to develop new products.    Although you may have paid a shareware or disk vendor a fee for 
the disk on which you obtained Wall-Ace, you should know the author receives none of that money.    
We believe that users are honest enough to register the program with the author.    Your registrations 
provide the incentive and the means for us to continue to support our products, and to develop and 
distribute new products.    If you don't think Wall-Ace is worth it, please send us mail (or e-mail) and 
tell us why -- perhaps your suggestions will be incorporated in a future version.

The evaluation copy of Wall-Ace will present a registration reminder screen each time Wall-Ace is 
started.    When you register Wall-Ace, you will receive a registration key that is derived from the 
spelling of your name.    This key will convert the evaluation copy of Wall-Ace into a registered copy 
without the reminder screen.    In addition, your name will appear in the About box as the registered 
user of this copy of Wall-Ace.    There is no fee for upgrades; your registration key will work for this 
and all future versions of Wall-Ace.    You may obtain future versions of Wall-Ace from any of the 
sources mentioned above; you do not need a new diskette copy.    If you prefer, you may receive new 
versions of Wall-Ace on disk, for only a disk shipping and handling fee.

The benefits of registration include:
A registered copy of the latest version of Wall-Ace.
Removal of the registration reminder screen.
All future versions at no additional cost.
Notification of updates and new products.
Support via mail or e-mail.
The legal right to continue to use the program after the evaluation period has ended.
A clear conscience.
A sense of pride and ownership, by having participated honestly in the shareware system.
The satisfaction of helping to support the shareware system.
Allows us to continue to support the program with additions, corrections, and enhancements.
Your comments and ideas help shape the future direction of this and other products.
As a bonus, you will receive a collection of beautiful full-screen wallpapers not available for 

download anywhere, either by e-mail at no cost, or on disk for just a disk shipping and handling fee.
All of this, along with our gratitude.

To register your copy of Wall-Ace, print and complete the order form, and send the completed form 
with the registration fee, to the address shown on the order form.

The order form may be printed directly from Wall-Ace, by pressing the Print Form command button in 
the Registration window, which is accessed by choosing Options|Register Wall-Ace... in the main 
window, or by pressing the Register command button in either the About window or the startup splash 
screen.

Alternatively, the order form may be printed by copying the orderfrm.txt file to your printer with the 



DOS command:

copy orderfrm.txt prn:

A copy of the order form is presented below.

                                                                    WALL-ACE ORDER FORM
                                                                Distribution 0302119612310101

Quantity Total

Wall-Ace Single User license only ________ @    $      9.95 ________

Wall-Ace Single User license with disk ________ @    $ 15.95 ________

BONUS full-screen wallpaper disks ________ @    $      6.00 ________

Shipping & Handling outside North America ________
(Europe $8.00, Asia & Australia $11.00)

TOTAL (U.S. dollars) ________

All amounts are in United States dollars.    Payments may be made by
cash, cheque, or money order, in any major world currency.    Please
make total amount equivalent to total U.S. dollar amount.

Contact the author for site licenses or other arrangements.

For license only shipping, please specify: [_] e-mail [_] post
License only orders will be sent by e-mail unless otherwise requested.

For license with disk shipping, please specify: [_] 3 1/2" [_] 5 1/4"
Disk orders will be sent on 3 1/2" disk unless otherwise requested.

________________________________________________________ ______________
Name Date

________________________________________________________________________
Title

________________________________________________________________________
Company

________________________________________________________________________
Street Address

________________________________________________________________________
City State/Province Zip/Postal Code

________________________________________________________________________
Country

________________________________________________________________________
Telephone (Day) (Evening) Fax

________________________________________________________________________
E-Mail Address

Please send payment with completed registration form to:



Sidney D. Peters
114 Laurentian Drive
Saskatoon, SK    S7H 4M2
Canada



COMMENTS AND SUGGESTIONS
                                            WALL-ACE COMMENTS AND SUGGESTIONS FORM
                                                                                    Distribution 0302119612310101

Please send us your comments, suggestions, bug reports, enhancement requests, or anything else you
would like to mention about Wall-Ace.    The questions are optional, and are for the purpose of helping 
us to improve our products and services, and to track their distribution.

Where did you obtain Wall-Ace from?
(Please specify name of site, service, bbs, distributor, book, etc.)
[_] FTP or Web site [_] On-line service [_] BBS [_] Other
[_] Shareware distributor [_] Book or magazine [_] Friend

Please specify:    _______________________________________________________

How would you rate Wall-Ace in each of the following categories:
Ease of use ______________________________________________________
Features ______________________________________________________
Documentation ______________________________________________________
Overall quality ______________________________________________________
Suitability to task ______________________________________________________

What would you say is Wall-Ace's best feature?    Worst feature?

What would you say is Wall-Ace's greatest strength?    Greatest weakness?

What attracted you to Wall-Ace?

For what reasons do you/would you register shareware?

What do like most about shareware?    Least?

What types of incentives do you like most?

What types of nags or other limitations do you like least?

What types of CPU do you use? What types of OS software do you use?
(check all that apply) (check all that apply)
[_] Pentium Pro [_] Windows NT [_] DOS
[_] Pentium [_] Windows 95 [_] Other___________
[_] 486 [_] Windows 3.x
[_] 386 [_] OS/2
[_] 286 or older [_] Linux/Unix

What types of shareware do you use?    Are you interested in?

Other comments, suggestions, etc.:    (use additional space if necessary)



CONTACTING THE AUTHOR
The author may be contacted by internet electronic-mail at:

s.peters@sk.sympatico.ca

or by postal mail at:

Sidney D. Peters
114 Laurentian Drive
Saskatoon, SK    S7H 4M2
Canada



Menu Bar
The menu bar makes available the following menus:    
File
Options
Help



File Menu
The File menu has the following choices:

Change Wallpaper:    immediately changes the wallpaper according the selection method set in 
Preferences, and resets the wallpaper timer.    If the Exit After First Change option is set, Wall-Ace 
exits.    This is the same as pressing the Change command button.

Exit:    causes Wall-Ace to exit.    The elapsed time in the current wallpaper timer interval, and the 
current window positions, are first saved to the initialization file, if selected in Preferences.    This is the 
same as pressing the Exit command button.



Options Menu
The Options menu has the following choices:

Preferences...:    displays the Preferences window, from which all options may be set.    This is the 
same as pressing the Preferences command button.

Edit Wallpaper File List...:    displays the Edit Wallpaper File List window, from which the wallpaper 
list may be edited. This is the same as pressing the File List command button.



Help Menu
The Help menu has the following choices:

Contents:    displays the Wall-Ace help file at the Contents page.

Register Wall-Ace...:    displays the Registration window.

About Wall-Ace...:    displays the About   Wall-Ace   window.



Current Wallpaper
A drop-down list box which lists all the wallpapers currently defined in your wallpaper list.    When Wall-
Ace starts, the current Windows wallpaper, as reported by win.ini, is the current item in this box, if it is 
in your wallpaper list.    If the current wallpaper is not in your list, the box's current item is empty but 
the entire list is still available by dropping it down in this box.    Selecting an item in this box 
immediately changes your Windows wallpaper to the selected item, and resets the wallpaper timer.    
The Exit After First Change option does not apply to direct selection via this list box, so Wall-Ace does 
not terminate.



Change Command Button
This command button immediately changes the wallpaper according the selection method set in 
Preferences, and resets the wallpaper timer.    If the Exit After First Change option is set, Wall-Ace 
exits.    This is the same as selecting Change Wallpaper from the File menu.



Prefs Command Button
This command button displays the Preferences window, from which all options may be set.    This is the 
same as selecting Preferences... from the Option menu.



File List Command Button
This command button displays the Edit Wallpaper File List window, from which the wallpaper list may 
be edited.    This is the same as selecting Edit Wallpaper File List... from the Option menu.



Exit Command Button
This command button causes Wall-Ace to exit.    The accumulated time in the current wallpaper timer 
interval, and the current window positions, are first saved to the initialization file, if selected in 
Preferences.    This is the same as selecting Exit from the File menu.



Selection Method Panel
This panel allows setting the selection method:

Random:    wallpapers are chosen randomly from the wallpaper list, with each being chosen the 
number of times indicated by its weight before the cycle is repeated.

Sequential:    wallpapers are chosen sequentially through the wallpaper list, and the list is then 
repeated, without regard to wallpaper weight settings.



General Options Panel
This panel allows setting the general options:

Change on startup:    if true, Wall-Ace will change the wallpaper according to the selection method 
specified in Preferences when it starts, in a manner identical to pressing the Change button in the main
window.    This option should not be used with the Exit After First Change option; see the topic Using 
The   Wall-Ace   General Options   in the OPERATION section for more information.

Exit after first change:    if true, Wall-Ace will exit immediately after changing the wallpaper either 
by pressing the Change button (or choosing Change Wallpaper from the File menu) in the main 
window, by a timed change, or by the Change On Startup option, but not by a direct wallpaper 
selection in the Current Wallpaper list box in the main window.    Before exiting, Wall-Ace will save the 
wallpaper timer current interval's elapsed time, and the current window positions, if selected in 
Preferences.    This option should not be used with the Change On Startup option; see the topic Using 
The   Wall-Ace   General Options   in the OPERATION section for more information.

Save window positions:    if true, Wall-Ace will save the current window positions when it exits, and 
will restore the saved positions when it starts.



Timer Panel
This panel allows setting the timer options:

Enabled:    if true, Wall-Ace will change the wallpaper at intervals of the selected length.    If false, 
timed changes will not occur.

Cumulative time:    if true, the time elapsed since the wallpaper was last changed is saved when 
Wall-Ace exits, and restored when Wall-Ace starts.    The first timed wallpaper change after Wall-Ace
next starts will occur upon completion of the saved time interval.    If false, the elapsed time is not 
saved or restored, and the first timed wallpaper change will occur one full interval after Wall-Ace 
starts.

Note that if the Change On Startup option is true, the wallpaper will be changed and the timer reset 
when Wall-Ace starts, so the Cumulative Time option will have no effect.

Interval Minutes:    specifies the number of minutes between timed wallpaper changes when the 
timer is enabled; the associated spinner provides for quick increases or decreases of the current time.



Auto Add Options Panel
This panel allows setting the auto add options:

Auto Add Enabled:    if true, each time Wall-Ace starts it searches your wallpaper directory, and 
automatically adds to your wallpaper list any bitmap (.bmp) files which are not already in the list.

Tile:    if true, wallpapers automatically added to the wallpaper list will have the tile attribute.

Center:    if true, wallpapers automatically added to the wallpaper list will have the center attribute.

Auto Select Tile/Center:    if true, each wallpaper automatically added to the wallpaper list will have 
the center attribute if its file size is greater than or equal to 100,000 bytes, and will have the tile 
attribute if its file size is less than 100,000 bytes.

Weight:    specifies the weight given to each wallpaper automatically added to the wallpaper list; the 
associated spinner provides for quick increases or decreases of the current weight.



Sound Options Panel
This panel allows setting the sounds to be playd when the wallpaper is changed:

Sounds Enabled:    if true, the specified sound file will be played each time the wallpaper is changed.

Auto Change:    specifies the sound file to be played when the wallpaper is changed due to the 
Change On Startup option or as a result of a timed change.

Manual Change:    specifies the sound file to be played when the wallpaper is changed by direct 
selection in the Current Wallpaper list box, by pressing the Change button, or by choosing Change 
Wallpaper from the File menu.

Begin Cycle:    specifies the sound file to be played when a Sequential or Random Cyclic change 
begins a new cycle.



File List Command Button
This command button displays the Edit Wallpaper File List window, from which the wallpaper list may 
be edited.    This is the same as the File List command button in the main window.



Help Command Button
This command button displays the Wall-Ace help file.



OK Command Button
This command button exits the Preferences window and causes all the Preferences to be saved in the 
initialization file, and used in the current session.



Cancel Command Button
This command button exits the Preferences window without saving any changes made, and without 
using any changes in the current session.



Drive Panel
This panel displays the currently selected drive, and allows selection of the drive for the sound file.



Directory Panel
This panel displays the currently selected directory on the currently selected drive, and allows 
selection of the sound file directory on that drive.



Sound File Panel
This panel displays all the sound (.wav) files in the currently selected directory of the currently selected
drive.    A file may be immediately played by double clicking, or by selecting the file and pressing the 
Test command button.



Current File Panel
This panel displays the currently selected drive, directory and sound file.



Test Command Button
This command button plays the selected sound file immdediately.



OK Command Button
This command button exits the Select Sound File window and causes the selected sound file to be 
used.



Cancel Command Button
This command button exits the Select Sound File window without changing the sound file.



Wallpaper Directory Panel
This panel allows setting and viewing the wallpaper directory.

Wallpaper Directory:    this text box displays the current wallpaper directory, and allows directly 
entering a new directory path.

Browse:    this command button displays the Select Wallpaper Directory window, from which a new 
wallpaper directory may be selected.



Drive Panel
This panel displays the currently selected drive, and allows selection of the source drive for wallpaper 
files to add to the wallpaper list.



Directory Panel
This panel displays the currently selected directory on the currently selected drive, and allows 
selection of the source directory on that drive    for wallpaper files to add to the wallpaper list.



Bitmap File Panel
This panel displays all the bitmap (.bmp) files available for addition to the wallpaper list, in the 
currently selected directory of the currently selected drive.



Current Directory Panel
This panel displays the currently selected drive and directory.



Wallpaper Panel
This panel displays the wallpaper list, showing for each wallpaper the full path and filename, the 
tile/center attribute, and the weight, and allows selection of one or more wallpapers to edit.    Double 
clicking is identical to pressing the Weight command button.



All Command Button
This command button selects all files in the Bitmap Files list box of the Files panel, for possible addition
to the wallpaper list.



Add Command Button
This command button adds the files selected in the Bitmap Files list box of the Files panel to the 
wallpaper list.    The added files' tile/center options and weights will be determined by the Auto Add 
Options selected in the Preferences window, in the same way as files automatically added, and may be
further edited after addition.



Remove Command Button
This command button removes the files selected in the Wallpaper List panel from the wallpaper list, 
after prompting for confirmation.



Clear Command Button
This command button clears (removes ALL files from) the wallpaper list, after prompting for 
confirmation.



Tile Command Button
This command button causes all files selected in the Wallpaper List panel to be given the tile attribute.



Center Command Button
This command button causes all files selected in the Wallpaper List panel to be given the center 
attribute.



Weight Command Button
This command button displays the Edit Weight window, allowing the weight to be set for all files 
selected in the Wallpaper List panel.



Help Command Button
This command button displays the Wall-Ace help file.



OK Command Button
This command button exits the Edit Wallpaper File List window and causes the wallpaper list to be 
saved in the initialization file, and used by the current session.



Cancel Command Button
This command button exits the Edit Wallpaper File List window without saving any changes made, and 
without using any changes in the current session.



Drive Panel
This panel displays the currently selected drive, and allows selection of the drive for the wallpaper 
directory.



Directory Panel
This panel displays the currently selected directory on the currently selected drive, and allows 
selection of the wallpaper directory on that drive.



Bitmap File Panel
This panel displays all the bitmap (.bmp) files in the currently selected directory of the currently 
selected drive.



Current Directory Panel
This panel displays the currently selected drive and directory.



OK Command Button
This command button exits the Select Wallpaper Directory window and causes the selected directory to
be displayed in the Wallpaper Directory text box of the Preferences window.



Cancel Command Button
This command button exits the Select Wallpaper Directory window without changing the contents of 
the Wallpaper Directory text box of the Preferences window.



Weight Panel
This text box allows direct entry of the weight to be used for all files selected in the Wallpaper List 
panel of the Edit Wallpaper File List window; the associated spinner provides for quick increases or 
decreases of the current weight.



OK Command Button
This command button exits the Edit Weight window and causes the specified weight to be used for all 
files selected in the Wallpaper List panel of the Edit Wallpaper File List window.



Cancel Command Button
This command button exits the Edit Weight window without changing the weights of the files selected 
in the Wallpaper List panel of the Edit Wallpaper File List window.



Copyright Panel
This panel displays the program version and copyright.



About Panel
This panel displays the program registration information.



Author Post Panel
This panel displays the author's postal address.



Author E-Mail Panel
This panel displays the author's e-mail address.



OK Command Button
This command button exits the About window.



Register Command Button
This command button displays the Registration window, from which you can print the registration form,
or enter your registration code to register your copy of Wall-Ace.



Registration Name Panel
Enter your registration name in this panel to register your copy of Wall-Ace.



Registration Code Panel
Enter your registration code in this panel to register your copy of Wall-Ace.



Print Form Command Button
This command button will print the Wall-Ace registration form and comments form, which are used to 
register your copy of Wall-Ace.



OK Command Button
This command button exits the Registration window.




